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Lesson

1 Introduction

Welcome to self paced training for Solid Edge. This course is designed to educate you
in the use of Solid Edge. The course is self-paced and contains instruction followed
by activities.

Solid Edge self-paced courses
• spse01510—Sketching

• spse01515—Constructing base features

• spse01520—Moving and rotating faces

• spse01525—Working with face relationships

• spse01530—Constructing treatment features

• spse01535—Constructing procedural features

• spse01536—Modeling synchronous and ordered features

• spse01540—Modeling assemblies

• spse01545—Creating detailed drawings

• spse01546—Sheet metal design

• spse01550—Practicing your skills with projects

• spse01560—Modeling a Part Using Surfaces

• spse01610—Solid Edge frame design

• spse01640—Assembly patterning

• spse01645—Assembly systems libraries

• spse01650—Working with large assemblies

• spse01655—Revising assemblies

• spse01660—Assembly reports

• spse01665—Replacing parts in an assembly

• spse01670—Designing in the context of an assembly
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Lesson 1 Introduction

• spse01675—Assembly features

• spse01680—Inspecting assemblies

• spse01685—Alternate assemblies

• spse01686—Adjustable parts and assemblies

• spse01690—Virtual components in assemblies

• spse01691—Exploding assemblies

• spse01692—Rendering assemblies

• spse01693—Animating assemblies

• spse01695—XpresRoute (tubing)

• spse01696—Creating a Wire Harness with Harness Design

• spse01424—Working with Solid Edge Embedded Client

Solid Edge self-paced modules

• spse01510—Sketching

• spse01515—Constructing base features

• spse01520—Moving and rotating faces

• spse01525—Working with geometric relationships

• spse01530—Constructing treatment features

• spse01535—Constructing procedural features

• spse01536—Modeling synchronous and ordered features

• spse01540—Modeling assemblies

• spse01545—Creating detailed drawings

• spse01546—Sheet metal design

• spse01550—Practicing your skills with projects

Start with the tutorials

Self-paced training begins where tutorials end. Tutorials are the quickest way for
you to become familiar with the basics of using Solid Edge. If you do not have any
experience with Solid Edge, please start by working through the tutorials for basic
part modeling and editing before starting this self-paced training.
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Introduction

This course provides step-by-step instructions for using the commands in the
Harness Design environment to create a harness design that contains several wires,
a cable, and a bundle.

Harness Design allows you to easily construct wires, cables, and bundles from one
point to another in an assembly. The Harness Design module provides a Harness
Wizard that automatically creates a harness design based on information contained
in an imported net list. The module also provides a structured workflow that quickly
defines a 3D path between parts and define wire, cable, and bundle properties. After
defining these properties, the software constructs the wire, cable, or bundle.

This tutorial does not demonstrate everything Harness Design can do. Its purpose is
to show you how powerful and intuitive Harness Design is, and to get you started so
that you can learn more on your own.
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Lesson

2 Wire harness design workflow

Wire harness design overview

You can use the Wire Harness application to work with assemblies containing
electrical conductors.

To activate the Wire Harness application, choose Tools tab®Environs
group®Harness.

Solid Edge Wire Harness Design is intended to work with round conductors only and
does not support ribbon cables.

Note

There is no limit on the number of conductors you can use in an assembly.

Generally, there are two design processes used in harness design. In the first design
process a 2D electrical schematic is developed first, and the 3D model is derived from
the schematic. In the second design process there is no 2D schematic or it is not
used in conjunction with the 3D model.

Harness design workflow

Based on the design process you use, there are two workflows for creating your
harness design:

• Automatic

• Manual
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Lesson 2 Wire harness design workflow

Creating the harness design automatically workflow

1. Create a new list either manually or with an ECAD system.

2. Use the Harness Wizard command to import the net list file to Solid Edge
to assign component, connection, and terminal information for the harness
design.

3. Use the Move and Assemble commands to position the automatically placed
components if the assembly is not already created.

4. Bundle and route wires and cables as needed.

5. Add any wires or cables that were not included in the net list.

6. Verify all conductors exceed the minimum bend radius and they have the
proper slack lengths.

7. Create manufacturing reports and create a 3D representation of the harness.

Creating the harness design manually workflow

1. Build the assembly to include all required components. You can place the
components in the Harness Design environment.

2. Create the wires and cables needed for your design.

3. Bundle and route wires and cables as needed.

4. Verify all conductors exceed the minimum bend radius and they have the
proper slack lengths.

5. Create manufacturing reports and create a 3D representation of the harness.

2-2 Creating a Wire Harness with Harness Design spse01696



Wire harness design workflow

Using BlueDots to Reposition Conductors and Components (ordered
environment)

Note

BlueDots are only available in the ordered environment.

After creating a wire harness in the ordered, you may need to reposition conductors
and components to clean up the design. When you create a cable or bundle, a
BlueDot is created at the point where the wires, cables, and bundles meet.

You can drag the BlueDot to change the path the bundle or cable follows.
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Lesson 2 Wire harness design workflow

Using the Harness Wizard to create harness designs automatically
The Harness Wizard command, located on the Tools tab®Harness group,
automatically creates a wire harness. The wizard uses information stored in an
imported net list file to populate the components and conductors in an assembly.

Note

Before running the wizard, you should use the Assign Terminals command
in the Part environment to assign component and terminal names for
components that will be used in the harness design.

When you select the command, a series of dialogs takes you through the process of
defining information about the wire harness.

To learn how to use the dialog box, see Using step 1 of the Harness Wizard.

To learn how to use the dialog box, see Using step 2 of the Harness Wizard.

To learn how to use the dialog box, see Using step 3 of the Harness Wizard.
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Wire harness design workflow

Using step 1 of the Harness Wizard

Use the Harness Wizard - Step 1 of 3 dialog box dialog box to specify:

• The format for the ECAD net list file.

• The component document used to create the harness.

• The conductor document used to create the harness.

Specify the format for the ECAD net list file

The Document Format option specifies the format for the net list file used to
create the wire harness. Use the menu to display a list of document types found
in the SEHarness.txt file.

The SEHarness.txt file, located in the Solid Edge Program folder, defines the
data format for the ECAD net list files used to create the wire harness.

The SEHarness.txt file contains three sections:

• The company name, which also represents the format displayed in the menu
list.

• The component definition used to define each column in the component file.

• The connection definition used to define each column in the connection file.

Specify the component document used to create the harness

The Component Document option specifies the component document used to
create the wire harness. The document can be in .CMP or .CMP_XML format.

The component document contains information such as the component id,
component name, and component description.

Specify the conductor document used to create the harness

The Connect Document option specifies the connection document used to create
the wire harness. The document can be in .CON or .CON_XML format.

The connection document contains information describing the connections in
the wire harness such as the component ID, color, and material, as well as the
component from ID and the component to ID.
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Lesson 2 Wire harness design workflow

Using step 2 of the Harness Wizard

Use the Harness Wizard - Step 2 of 3 dialog box dialog box to specify:

• Assign components to a Component ID

• Assign occurrences of component part files already in the assembly

• Populate components into the assembly

Assign components

If you do not use the Assign Terminals command to make your component
and terminal assignments before running the wizard, your component file
will contain a component that has not been assigned. If your file contains an
unassigned component, the component will be displayed in orange in the table.
You do not have to exit the wizard to assign components.

To assign a component:

1. Click the component in the Components table.

2. Click the Assign Component command.

3. Click the part you want to assign the component to. The component is
populated in the table and the Status and Occurrence Name columns are
no longer highlighted.

You can right-click the Occurrences Name column for the component and click
Browse on the shortcut menu to search for the part.

Note

A part can contain only one component.

Assign occurrences

When components are imported prior to running the wizard, Solid Edge
automatically assigns an instance to all duplicate parts in the assembly based
on the order in which the parts are encountered. If the occurrences get out of
order, you can use the Assign Occurrence command to change the occurrences
for a component.

To assign an occurrence when a component has already been assigned:

1. Click the highlighted row for the component containing the occurrence you
want to change.

2. Click the Assign Occurrence button.

3. Click the component you want to assign the occurrence to.

If the same part file is selected, the two part files swap instances. If the selected
part is not associated with a component, the part is assigned to the highlighted
component.
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Wire harness design workflow

To assign an occurrence when a component has not been assigned:

1. Click the Assign Occurrence button.

2. Click the component you want to assign the occurrence to.

If the selected part is not associated with a component, the part is assigned to
the highlighted component. If the part is associated with a component, an error
message is displayed.

Populate components

If a part listed in the components file is missing from the assembly, you can
populate the component while in the harness wizard. All parts must be
populated before you can proceed to the next step in the wizard. You can add the
parts through the wizard or you can add them manually.

To populate a component:

1. Right-click in the Occurrence column for the highlighted component.

2. On the shortcut menu, click Browse to display the Open dialog box.

3. Select the appropriate part and click the Open button.

4. Click the Populate button.

Note

You do not have to click the Populate button after each browse. You
can browse for all parts and then click the Populate button.

When populating components in an assembly, click the Populate Options button
to display the Harness Populate Options dialog box, which allows you to define
information for an array of the components being brought into the assembly.

The array contains information about the components, but it does not know
where the parts associated with these components should be placed in the
assembly. Since the part position is unknown, the parts are placed on the Top
(XY) reference plane. Use the Assemble command to position the parts in the
appropriate location after the wizard is complete.
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Lesson 2 Wire harness design workflow

Using step 3 of the Harness Wizard

This dialog box displays information about the connections used to create the wire
harness. You can use options on this dialog box to:

• Assign terminals on the component parts

• Delete wires from the harness

• Assign Attributes to a wire or cable

• Preview the harness

• Assign terminals

If your file contains undefined terminals, they highlight in orange. As with
components, you do not have to exit the wizard to assign a terminal.

To assign a terminal:

1. Click the terminal in the Connections table.

2. Click the Assign Terminal button.

3. In the graphic window, click the circular edge on the hightlighted part you
want to assign the terminal to. The terminal is assigned and the cells are
no longer highlighted.

• Delete wires from the harness

If a wire listed in the connections document is not needed in the wire harness,
you can delete it.

To delete a wire from the harness:

1. Right-click the wire you want to delete.

2. On the shortcut menu, click Delete Wire From Harness.

• Assign attributes to a wire or cable

You can assign attributes to a wire or cable while working in the wizard.

To assign an attribute to a wire:

1. Click the Solid Edge Attribute column for the wire.

2. Click the menu arrow.

The list includes attributes for the type of wire selected. For example, if the
wire is 16 gage, the list will display only attributes for a 16 gage wire. There
is also a Remove Filter entry in the list which allows you to remove the filter
and display attributes for other types of wire.

3. Select an attribute from the list.
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Wire harness design workflow

To assign an attribute to a cable:

1. Click the Cable Attribute column for the cable.

2. Click the menu arrow.

The list includes attributes for the type of cable selected. There is also a
Remove Filter entry in the list which allows you to remove the filter and
display attributes for other types of cable.

3. Select an attribute from the list.

• Preview the harness

You can use the Preview button on the wizard to preview the harness. You can
preview a single connection or use the Shift and Ctrl keys to preview multiple
connections.

To preview the harness:

1. Select the connection you want to preview.

2. Click the Preview button.

A straight line preview of the connection is displayed in the assembly.

After ensuring the information on the wizard is correct, click Finish to create
the harness.
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Lesson 2 Wire harness design workflow

Once the harness is complete, you can use the Cable or Bundle command to
group the wires or cables in the design.

After creating a wire harness, you may need to reposition conductors and
components to clean up the design. When you create a cable or bundle, a bluedot
is created at the point where the wires, cables, and bundles meet.

You can drag the bluedot to change the path the bundle or cable follows.

You can also clean up the harness design by using the Move command to drag a
component to a new location.
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Wire harness design workflow

Once you move the component to a new location, the link to the conductors is
automatically updated.
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Lesson 2 Wire harness design workflow

PathFinder in harness design
As you create paths and conductors, they are added to PathFinder.
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Wire harness design workflow

If you move the cursor over a conductor in PathFinder, all occurrences of the
conductor are outlined with a red box,

and they are highlighted in the graphics window.
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Lesson 2 Wire harness design workflow

Notice that the wire you highlighted is displayed in a solid color until the point it
becomes part of a cable. At that point, the display becomes a dashed line. Also notice
that the color of the dashed line changes at the point the cable and wires become
part of a bundle.

If you position the cursor over a cable in PathFinder, all occurrences of the cable
are outlined and the cable highlights in a solid color and the bundle containing
the cable highlights as a dashed line. Notice that the wires included in the cable
do not highlight.

If you position the cursor over a bundle in PathFinder, all occurrences of the bundle
are outlined and the bundle highlights in a solid color. Notice that the wires and
cables included in the bundle do not highlight.

You can right-click on a conductor in PathFinder to display a list of shortcut
commands that allow you to manipulate the conductors.
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Wire harness design workflow

Removing conductors
You can use the Remove command to remove a conductor from its parent. To access
the command, right-click the mouse button on a conductor and on the shortcut
menu, click Remove.

When you remove a conductor from a higher level object, it is removed from the
definition of all higher level objects. The existing to and from points of the conductor
are maintained. The path segment(s) shared between the selected conductor and its
higher level is removed from the conductor’s definition. A new segment is generated
to replace the segment that was removed.
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Lesson 2 Wire harness design workflow

Creating wire harness solid bodies
You can use the Create Physical Conductor command to create a solid body of the
wires, cables, and bundles that make up the harness design. This is useful when you
need a rendering or detailed drawing of your harness design,

To access the command, right-click on a conductor in PathFinder. The solid body that
is created is only for the selected conductor. In other words, if you select a cable, the
command does not create solid bodies for the wires contained in the cable. You can
right-click on the Harness node in Assembly PathFinder to create all of the solids
at once. The solid bodies are embedded in the assembly and no new documents are
added to the assembly.

Note

Any paths found in the harness design that do not contain attributes will not
be included in the creation of the solid body.

When you create a solid body for a conductor, the symbol adjacent to the conductor
in PathFinder is updated to indicate that a solid body has been created for the
conductor.

Note

To select multiple conductors, you can hold down the Ctrl key, and then
click the conductors you want. To select a list of conductors, click on the
first conductor in the list, hold down the Shift key, and then click the last
conductor in the list.

After you create a solid body for a conductor, additional shortcut menu commands
are available to manipulate the solid bodies.

You can use the Show Physical Conductor and Hide Physical Conductor commands
to control the display of the solid bodies. The solid body is automatically shown on
creation, so you can use the Hide Physical Conductor command to conceal the newly
created body. Changes made to the display of the physical body do no affect the
display state of the conductor used to create the body.

You can use the Delete Physical Conductor command to delete the solid body without
deleting the conductor.
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Wire harness design workflow

Outputting wire harnesses to other formats
You can use the Save As ECAD command to save your wire harness component and
connection information so that it can be used by other ECAD software systems. You
can export the information to ECAD system-specific format or to .XML format.

Note

The command will only export information for conductors that have been
attributed. Any paths that do not contain attributes will not be included in
the file.

When you select the command, the Save As ECAD dialog box is displayed. You can
use this dialog box to specify the format to which you want to save the information.
You can also specify the name, location, and format of the components and
connections files.

The components file contains information about the components in the wire harness
such as the unique id, component name, and component description. You can save
the components file to .CMP or .CMP_XML format.

The connection file contains information about the connections in the wire harness
such as the wire id, fromcomponentid, and the tocomponentid. You can save the
components file to .CON or .CON_XML format.
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Lesson

3 Activity: Create a wire harness

This activity guides you through the creation of a harness design that contains
several wires, a cable, and a bundle.

Turn to Appendix A for the activity.
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A Activity: Creating a wire harness
with Harness Design

Open activity file

▸ Open the assembly harness.asm.
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A Activity: Creating a wire harness with Harness Design

Open the Harness Design environment

▸ Click Tools tab®Environs group®Harness Design.

The system displays the Wire Harness environment. The ribbon contains the
commands you use to create wire harness conductors (wires, cables, or bundles).

You will use PathFinder for most of this activity.
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Activity: Creating a wire harness with Harness Design

Activate the parts in the assembly

This activity requires that the parts in the assembly are active. Several factors
determine whether or not all parts within the assembly are active on your computer.

▸ To ensure that the parts are active, in PathFinder, right-click the
harness.asm entry, and click Activate on the shortcut menu.
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A Activity: Creating a wire harness with Harness Design

Hide the console part

▸ In PathFinder, position the cursor over the Console1.par entry, and then
right-click to display the shortcut menu.

▸ On the shortcut menu, click Hide to hide the console part.
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Activity: Creating a wire harness with Harness Design

Start the Harness Wizard

The Harness Wizard consists of three dialog boxes that create a harness design
automatically based on information contained in an imported net list file.

▸ On the ribbon, click Home tab®Wizard group®Harness Wizard .
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A Activity: Creating a wire harness with Harness Design

Specify information for Harness Wizard Step - 1 of 3

The Harness Wizard - Step 1 of 3 dialog box specifies:

• The format for the eCAD net list file.

• The component document used to create the harness.

• The conductor document used to create the harness.

▸ From the Document list, select Sample.

▸ In the Component document box, use the Browse button to select
harness1.cmp in the folder containing the activity files.

▸ In the Connection document box,use the Browse button to select harness1.con
in the folder containing the activity files.

▸ Click the Next button.
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Activity: Creating a wire harness with Harness Design

Specify information for Harness Wizard Step - 2 of 3

The Harness Wizard - Step 2 of 3 dialog box displays information about the
components used to create the wire harness. The dialog box contains commands
and options that allow you to:

• Assign components.

• Assign occurrences.

• Populate components.

Notice that the status for component Volume1 is Not Populated. This indicates
that the component has not been assigned to a part. Normally, you would use the
Assign Terminals command to assign components and terminals before running
the wizard. However, if this has not been done, you can make these assignments
within the wizard.

▸ Right click the row containing Volume1 and click Assign Component.

▸ In the graphics window, click Potentiometer2.par, as shown in the illustration.
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A Activity: Creating a wire harness with Harness Design

Notice that the dialog box updates to indicate the status of Volume1 is now
populated.

▸ Click the Next button.
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Activity: Creating a wire harness with Harness Design

Specify information for Harness Wizard Step - 3 of 3

The Harness Wizard - Step 3 of 3 dialog box displays information about the
conductors used to create the wire harness. The dialog box contains commands
that allow you to:

• Assign terminals.

• Delete wires from the harness.

• Assign attributes to a wire or cable.

• Preview the harness.

Notice that there are three From Terminals highlighted in orange and the status
for these terminals is Not Defined. These represent terminals on the Volume1
component that need to be defined.
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A Activity: Creating a wire harness with Harness Design

Assign terminal A

▸ Right click From Terminal a and click Assign Terminal.

▸ On the status bar at the bottom of the window, click the Zoom Area button

.

▸ Click above and to the left of Potetionmeter2.par, and then again below
and to the right as shown in the illustration. This defines a rectangle that
becomes the view area.

▸ Right-click to end the Zoom Area command.

▸ Click the circular edge to assign terminal a.
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Activity: Creating a wire harness with Harness Design

Assign terminal B

▸ Right click From Terminal b and click Assign Terminal.

▸ Click the circular edge to assign the terminal.
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A Activity: Creating a wire harness with Harness Design

Assign terminal C

▸ Right click From Terminal c and click Assign Terminal.

▸ Click the circular edge to assign the terminal.

▸ Click the Finish button to complete the wizard.
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Activity: Creating a wire harness with Harness Design

Fit the view

▸ Click the View tab®Orient Group®Fit command to fit the assembly in the
window.
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A Activity: Creating a wire harness with Harness Design

View PathFinder

▸ In PathFinder, click the + symbol adjacent to the Wires entry.

Notice entries have been added for every wire created with the Harness Wizard.
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Activity: Creating a wire harness with Harness Design

Create a bundle

The Bundle command creates a harness bundle from a set of wires and cables. The
result is a single path that can be created across several components within the
harness assembly. When defining the path, you can define points to create the path
or you can select an existing path created with the Path command. For this bundle, a
path has already been created.

▸ In PathFinder, click the arrow next to the Paths entry.

▸ Right-click Path_1 and click Show on the shortcut menu.

▸ Click the Home tab®Harness group®Bundle command .

▸ Click and drag a box around plug14.par, as shown in the illustration, to
select the wires to include in the bundle.

▸ Click the Accept button.

▸ Select the Use Existing Path button on the command bar.
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A Activity: Creating a wire harness with Harness Design

▸ Click the existing path shown in the illustration.

▸ Click the Accept button.

▸ Click Preview and then click Finish.
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Activity: Creating a wire harness with Harness Design

Re-select the Harness Wizard command

You need to use the Harness Wizard to place another set of wires in the assembly.

▸ Click the Home tab®Wizard group®Harness Wizard button .

▸ In the Harness Wizard - Step 1 of 3 dialog box:

▸ From the Document list, select Sample.

▸ In the Component document box, use the Browse button to select
harness2.cmp.

▸ In the Connection document box, use the Browse button to select
harness2.con.

▸ Click the Next button.

▸ In the Harness Wizard - Step 2 of 3 dialog box, click the Next button.

▸ In the Harness Wizard - Step 3 of 3 dialog box, click the Finish button.
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A Activity: Creating a wire harness with Harness Design

Change the assembly display

▸ On the status bar at the bottom of the window, click the Visible and Hidden

Edges button .
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Activity: Creating a wire harness with Harness Design

Zoom in on the assembly

▸ On the status bar at the bottom of the window, click the Zoom Area button

.

▸ Drag a box around plug4.par, as shown in the illustration. This defines a
rectangle that becomes the view area.

▸ Right-click to end the Zoom Area command.
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A Activity: Creating a wire harness with Harness Design

Create a wire

▸ Click the Home tab®Harness group®Wire command .
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Activity: Creating a wire harness with Harness Design

Select the first point for the wire

▸ Make sure the Create Path button is selected .

▸ Click the Keypoint Locate button .

▸ Click the Keypoints button . From the Keypoints list, select Center Point

.

▸ Locate the center point shown in the illustration, and when it highlights,
click to select it.
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A Activity: Creating a wire harness with Harness Design

Fit the view

▸ Click View tab®Orient Group®Fit to fit the assembly in the window.
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Activity: Creating a wire harness with Harness Design

Zoom in on the upper gauge

▸ Use the Zoom Area command to zoom in on the area shown.

▸ Right-click to end the Zoom Area command.
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A Activity: Creating a wire harness with Harness Design

Select the end point for the wire

▸ Locate the center point shown in the illustration, and when it highlights,
click to select it.

▸ Position the cursor above and beyond the terminal as shown in the
illustration, and right-click to accept the end point.

▸ Set the Material as shown in the illustration.

▸ Click the Preview button.
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Activity: Creating a wire harness with Harness Design

Finish the wire

▸ Click the Finish button to complete the wire.
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A Activity: Creating a wire harness with Harness Design

Fit the view

▸ Click View tab®Orient Group®Fit to fit the assembly in the window.
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Activity: Creating a wire harness with Harness Design

Zoom in on the assembly

▸ Select the Zoom Area command .

▸ Zoom in on plug4.par. Right-click to end the command.
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A Activity: Creating a wire harness with Harness Design

Create another wire

▸ Click Home tab®Harness group®Wire .

Use the same options you used to create the first wire.

▸ Select the circular edge shown in the illustration to define the first point
for the wire.

▸ Select the circular edge shown in the illustration to define the end point
for the wire.
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Activity: Creating a wire harness with Harness Design

▸ Position the wire as shown in the illustration and click the Accept button.

▸ Set the Material as shown in the illustration.

▸ Click the Preview button.
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A Activity: Creating a wire harness with Harness Design

Finish the wire

▸ Click the Finish button to complete the wire.
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Activity: Creating a wire harness with Harness Design

Fit the view

▸ Click View tab®Orient Group®Fit to fit the assembly in the window.
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A Activity: Creating a wire harness with Harness Design

Create a cable

▸ Click the Home tab®Harness group®Cable command .

▸ Drag a box around plug4.par, as shown in the illustration, to select the wires
to include in the cable.

▸ Click the Accept button.

▸ Make sure the Create Path button is selected .

▸ Create the path as shown in the illustration.
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Activity: Creating a wire harness with Harness Design

▸ Set the Material to 22/15-gage Stranded Copper Gray as shown in the
illustration.

▸ Click Preview and then click Finish.
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A Activity: Creating a wire harness with Harness Design

Shade the view

▸ On the status bar at the bottom of the window, click Shade with Visible

Edges .
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Activity: Creating a wire harness with Harness Design

Create a solid body of the wire harness

▸ Click the Home tab®Select group®Select Tool button .

▸ In PathFinder, right-click the Harness entry to display the shortcut menu.

▸ On the shortcut menu, click Create Physical Conductor.

The system processes for a few seconds, then solid bodies are created for the
harness conductors.
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A Activity: Creating a wire harness with Harness Design

Change the view orientation

▸ Press Ctrl+R to align the view with the Right view.
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Activity: Creating a wire harness with Harness Design

Zoom in on the assembly

▸ Use the Zoom Area command to zoom in on rocker1.par, as shown in
the illustration.
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A Activity: Creating a wire harness with Harness Design

Move a wire

▸ Position the cursor over the path shown highlighted in the illustration
above, stop moving the mouse for a moment, and notice that the cursor
image changes to indicate that multiple selections are available. Also notice
that the cursor image indicates which button you must click to display the

QuickPick list. In this case, the right mouse button .

▸ Click the right mouse button, and the QuickPick list is displayed. Move
the cursor over the different entries in QuickPick, and notice that different
elements of the model highlight. QuickPick allows you to select exactly
the element you want, the first time, without having to reject unwanted
elements.

▸ Use QuickPick to highlight the path used to define Wire 9 and then click the
right mouse button.. In this example, it is Path_25, but your path may have
a different name. If multiple paths are displayed in QuickPick, select the
path closest to the occurrence in Rocker1.par.

▸ On the shortcut menu, click Edit Definition.
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Activity: Creating a wire harness with Harness Design

▸ Click the point shown in the illustration.

▸ Drag the point to the approximate location shown in the illustration, and
then right-click to place the wire.
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A Activity: Creating a wire harness with Harness Design

Move two more wires

▸ Use the method described in the previous step to move the path used to
define wire 7.
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Activity: Creating a wire harness with Harness Design

▸ and the path used to define wire 8.

After you have moved these wires, the wire harness should look similar to the
illustration above.
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A Activity: Creating a wire harness with Harness Design

Fit the view

▸ Click View tab®Orient Group®Fit to fit the assembly in the window.
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Activity: Creating a wire harness with Harness Design

Change the view orientation

▸ Press Ctrl+I to align the view with the Isometric view.
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A Activity: Creating a wire harness with Harness Design

Display a hidden part

▸ In PathFinder, right-click the Console1.par entry, and then click Show. This
displays the hidden part.
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Activity: Creating a wire harness with Harness Design

Hide the wires in the harness

▸ In PathFinder, right-click the Wires entry, and then click Hide to hide the
wires.
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A Activity: Creating a wire harness with Harness Design

Create a Wire Harness Report

You can create a report that lists the components and connections contained in
an assembly.

▸ Click Tools tab®Assistants group®Harness Reports.

▸ In the Harness Report dialog box:

▸ Select the Connections option.

▸ Select All harness connections in the assembly.

▸ Click OK to generate the report.
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Activity: Creating a wire harness with Harness Design

A report dialog box displays a list of cables expanded into an indented list
of the wire paths.

You can generate a report based on all components or connections in the
assembly, the components or connections that are currently shown in the
assembly, or the components or connections that are currently selected in the
assembly. You can save reports, print reports, and copy reports to the clipboard.

▸ Click the Close button to dismiss the report.
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A Activity: Creating a wire harness with Harness Design

Return to the Assembly environment

▸ Click the Tools tab®Close group®Close Harness button .
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Activity: Creating a wire harness with Harness Design

Save the file

▸ On the Quick Access toolbar, click the Save button to save the document .

Activity complete

• Try modifying the wires using the Properties dialog box.

• This completes the activity.
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Appendix

B Lesson review

Answer the following questions:

1. What two design processes are used in harness design?

2. What type of wires can created using wiring harness design?

3. When using ECAD net list files, where is the data format defined?

4. In the Harness Wizard, which option specifies the component document used to
create the wire harness?

5. In the Harness Wizard, which option specifies the connection document used to
create the wire harness?
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C Answers

1. What two design processes are used in harness design?

In the first design process a 2D electrical schematic is developed first, and the
3D model is derived from the schematic. In the second design process there is no
2D schematic or it is not used in conjunction with the 3D model.

2. What type of wires can created using wiring harness design?

Round conductors are supported. Ribbon cables are not supported.

3. When using ECAD net list files, where is the data format defined?

The SEHarness.txt file, located in the Solid Edge Program folder, defines the data
format for the ECAD net list files used to create the wire harness.

4. In the Harness Wizard, which option specifies the component document used to
create the wire harness?

The Component Document option specifies the component document used to
create the wire harness. The document can be in .CMP or .CMP_XML format..

5. In the Harness Wizard, which option specifies the connection document used to
create the wire harness?

The Connect Document option specifies the connection document used to create
the wire harness. The document can be in .CON or .CON_XML format.
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Appendix

D Lesson summary

In this lesson, you learned how to use the wire harness wizard to open an ECAD
component document and a connection document and define wires, bundles, cables
and group them accordingly. A harness report was generated defining the source and
destination of each wire and their associated properties.
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